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Crestron Voting Module v2
Module Application Guide

Description

This module provides voting functions on a Crestron 2-series processor. All voting functions
are completed in the Crestron processor. A PC is required only for optional agenda
information import (from Microsoft PowerPoint) or results data export (to Microsoft Excel).
This module can also be used to provide “request-to-speak” functionality, triggering
microphones to activate or pan/tilt/zoom cameras to move.

This module provides users with the ability to:

Import agenda information from PowerPoint (via Crestron e-PowerPoint)

Add “ad hoc” agenda items using a QWERTY keyboard on the Crestron touchpanel
Export voting results to Excel (via Crestron e-Datalog)

Rename, store and recall 5 different meeting groups of 15 members each to compact
flash. This will store the name of the meeting type, voting rules, the names of each
member, and the seating chart.

Modify and record attendance

Start and stop voting process

View voting results on a display device driven by a TPS-G-TPI or C2N-DVP4DI

Vote yea, nay or abstain

Select “Unanimous,” “2/3,” “3/4,” “4/5,” or “Majority” voting modes

Set and display a vote count-down timer, allowing delegates a certain amount of time
to place their votes

Vote from either the total number of delegates, or only the number currently present
Select if the system should automatically close the vote after all votes have been cast
Utilize a variety of interfaces for the delegates, including Crestron keypads or
touchpanels

Compatibility Processor Requirements
1 1) 2-Serles NOT CNMSX T Al 77 Ethernet Compact Flash
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= Request to speak, which will present the chairman with a list of users who are in the
queue. The chairman is then able to give any user the floor, remove any user from the

queue, remove all users from the queue, etc.
= Assign and store seating arrangements for each group, including flagging some seats

as unused to provide a dynamic group size.
= Store a backup of meeting records to the Crestron Compact Flash card.

Contract Programming Services

ControlWorks offers an extensive range of contract programming services in addition to our
online module library. This module was developed over the course of voting and request to
speak related projects in the course of these activities. Many of our past systems have had
additional, unique functionality.

If your application requires more than 15 delegates, access to a specific non-PowerPoint
agenda resource, an auditable paper trail of the ballots or any other customization, please
feel free to contact us at 440.449.1100 or support@controlworks.com.
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Module Application

It is strongly suggested that you load the supplied demonstration program and touchpanel to
gain an understanding of the application of the module before you attempt to implement the
module in your own program. In fact, many programmers fine it easiest to take our demo
program and add A/V and other functionality to it, rather than adding this module to another
program. It will make things very difficult if you do not run and fully understand the
operation of the demo program before attempting to use this module in another
program.

In order to use this module, you must have inserted a Compact Flash card into your Crestron
processor. ControlWorks supports only the use of SanDisk compact flash cards with Crestron
processors. If you are having problems and are using another manufacturer’s compact flash
card, do not call until you have replaced the card with a genuine SanDisk card.

NVRAM disk is not appropriate for this application, as one of the functions is storing a backup of
the voting results. The Compact Flash card can be removed and the contents read from a PC in
the event that the backup data needs to be accessed.

Copy the contents of the distribution ZIP file into the same folder as your program. Re-synch
your program, and then copy and paste the ControlWorks_ Voting v2 module into your program
from the demonstration program. Connect the signals to your touchpanels or keypads, the
optional e-Datalog symbol, and the optional e-PowerPoint symbol.

At this point you should be able to run the module successfully. Begin by entering names for the
meeting types and users, and creating a seating chart.

Important Note: The user names and seating chart are stored during the shutdown sequence.
The input system_power_off must be pulsed at the end of the meeting, or your database will
not be stored.
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E-PowerPoint Configuration

If you are using the optional agenda import from PowerPoint, you must first install Crestron’s
e-PowerPoint application on the computer that will supply the agenda. You will also need to
add the e-PowerPoint symbol in SIMPL Windows on the same IP ID with the loopback IP
address in the IP table (127.0.0.1). See the demo program for an example of the
implementation of the e-PowerPoint symbol in SIMPL Windows.

To configure e-PowerPoint’s connection to the Crestron processor, install the application on
the computer that will host the agenda information, launch the application, and select
Connection.

| Connechion - Inactive

Enter the IP address of the control system processor in both fields, and the unique IP ID you
assigned in SIMPL windows. Check the Auto Connect box.

4 e-PowerPoint

— Connechion

Cantral Spster IP Address |1 02094

Gateway IP Address |1 02094

IF1D: |5 Connect

Auwta Connect [ Dizzonhest

You should now see the connection listed as active in the status bar. If not, close the
application and launch it again. Make sure the IP table on the processor reflects the loopback
address of 127.0.0.1 on the assigned IP ID.

Connection - Active
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It is now necessary to setup a shortcut to the PowerPoint file that will contain the agenda
information. Choose File > Shortcuts.

Y e-PowerPoint
Fil= Help

Open Presentation
End Presentation

End PowerPaink

Exit %

Click on the text box labeled Shortcut 1. Browse to the file that will contain the agenda
information. This PowerPoint file will be opened and read when the user requests agenda
information from the touchpanel. The “title” field of each PowerPoint slide should contain an
agenda item. This allows users to modify their agenda easily on any computer running
Microsoft PowerPoint.

x|

Click a field below to select a file

— Shortcuts
1 I.f-‘-.genda.ppt F |
2 | 7]
3| 8 |
4 9 |
g | 10 |

Daone

e-PowerPoint will need to be running at all times during the voting process in order for
agenda information to be available. If the computer is dedicated to the Voting system, it is
recommended that e-PowerPoint be put in the Windows “Start Up” folder.
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E-Datalog Configuration

If you are using the optional voting results export to Excel, you must first install Crestron’s e-
Datalog application on the computer that will receive the results. You will also need to add
the e-Datalog symbol in SIMPL Windows on the same IP ID with the loopback IP address in
the IP table (127.0.0.1). See the demo program for an example of the implementation of the
e-DatalLog symbol in SIMPL Windows.

To configure e-Datalog’s connection to the Crestron processor, install the application on the
computer that will host the agenda information, launch the application, and select View >
Systems.

F T
Yiew Help

Events

If there is no system listed, click Add System. If there is already a system listed, highlight
it and click Edit System.

Enter the IP address of the control system processor in both fields, and the unique IP ID you
assigned in SIMPL windows. Check the Enabled box.

4 e-Datalog - Edit System x|

Edit System Information

Mame: [Frocessor

e

P Address: |1|:|_2.I:|.94

Gateway Address: |1|:|_2.EI.EI4

IF1D: ||:|4 vI

Enabled

0k LCancel |

You should now see the connection listed as online in the Systems list. If not, close the
application and launch it again. Make sure the IP table on the processor reflects the loopback
address of 127.0.0.1 on the assigned IP ID. Confirm that the Enabled box is checked for the
system.
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Spztem Hame IP Address Status
Froceszsor 10.2.0594

In order to view the data that is being recorded during or after a voting session, click View >
Events.

View  Syskbem

'm
Syskems

Once the session is over, click File > Export to Excel to copy the data from the Crestron
application to a Microsoft Excel file. This allows the users to take a copy of the voting results
for use on any computer with Microsoft Excel. If it is desired to clear the Crestron
application’s records before the next meeting, select File > Clear Datalog. This should be
done only after a copy has been exported to Excel.

m System Event Detailz -
Export bo Text i | Processor “ote Qutcome for: Hire 3 Mew Police Officers Pazs
Clear Datalog i | Processor Yating Rules for: Hire 3 Mew Police Officers b ajarity
Setup e-Datalog { | Processor obe on: Hire 3 Mew Police Officers by The Great Gonz | Yea [
Exit i | Processor Yate on: Hire 3 Mew Police Officers by Louis K.azagger | Mot Present
B/9/2006 [ 17:47. 33 AM| Processor “ote on; Hire 3 Mew Police Dfficers byGeonge Hay
B/9/2006 [ 17:47.32 M| Processor Yate on: Hire 3 Mew Police Officers by Swedish Chef | Map
B/9/2006 [ 17:47.32 M| Processor Yaote on: Hire 3 Mew Police Dfficers by Beaker Yea
B/9/2006 [ 17:47.32 M| Processor Yate on: Hire 3 Mew Police Officers by Animal Yea
B/9/2006 [ 17:47.32 M| Processor Yate on: Hire 3 Mew Police Officers by Fozzie Bear Yea
B/9/2006 [ 17:47.32 M| Processor Yate on: Hire 3 Mew Police Officers by Kermit The Frog |Yea
B/9/2006 [ 17:47.32 M| Processor “ate on: Hire 3 Mew Police Officers by Scooter Yea
B/9/2006 [ 17:47.32 M| Processor Yote on: Hire 3 Mew Police Dfficers by Migel Yea
B/9/2006 17:47:31 AM| Processor Yote on: Hire 3 Mew Police Officers by Crazy Hary Yea
B/9/2006 17:47:31 AM| Processor Yote on: Hire 3 Mew Police Officers by Scoffs Hay
B/9/2006 17:47:31 AM| Processor Yaote on: Hire 3 Mew Police Officers by Misz Piggy Yea
B/9/2006 17:47:31 AM| Processor Yate on: Hire 3 Mew Police Officers by Dr. Bunson Hon | Yea
B/9/2006 17:47:31 AM| Processor Yaote on: Hire 3 Mew Police Dfficers by B obin Yea
B/9/2006 [ 11:47.21 A | Proceszsor “ote Fecorded Hire 2 Mew Police Qfficers
B/9/2006 [ 17:13:47 AbM| Processor Yaote Outcome for; Approve repaving of Elm Strest F ail
B/9/2006 [ 17:13:47 AbM| Processor Yobe on; Approve repaving of Elm Street by Scoater Yea
B/9/2006 [ 17:13:47 AbM| Processor Yale on; Approve repaving of Elm Street bylGeorge Hay 1

e-Datalog will need to be running at all times during the voting process in order for voting
results to be available for export to Excel. If the computer is dedicated to the Voting system,
it is recommended that e-Datalog be put in the Windows “Start Up” folder.

Text files containing the voting results from the most recent 5 sessions can also be found on
the compact flash card.
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A Note on Addressing and Terminology

Whenever the module refers to a “member” it is describing an individual’s name in the group
database entry. When the module refers to a “seat” it is referring to a particular location and
its associated keypad or touchpanel. A “user” refers to the “member” sitting in the “seat.”

Please view the seating arrangement page of the demo touchpanel for our recommended
addressing strategy. By addressing the center most seat as 1 and working outward, the
following benefits can be obtained:

= The user in the center seat (usually the chairman) will appear at the top of the voting
lists

= Smaller groups (that contain fewer members) will have all of the votes appear grouped
together at the top of the voting results list, rather than scattered throughout the
screen

The voting result page in our demo program will display fields only for seats that have a

member assigned. If a seat has been marked as unused, the field will be hidden to clean up
the output. This is done with multimode objects.

Maximum String Lengths

The following are the maximum lengths of the various strings used in this module:

User Names ..o 24 characters
Meeting Type NamesS......ccciiiiiiiieeeeeennn. 24 characters
Agenda IteMS ... 30 characters (limitation of ePowerPoint 1.04,

call us to discuss options for using longer
agenda items)

Crestron Voting Module V2 ControlWorks Consulting, LLC
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Signhal and Parameter Descriptions

Bracketed signals such as “[signal_name]” are optional signhals

DIGITAL INPUTS
e_powerpoint_launch

e_powerpoint_close

system_power_off

page_splash_fb

page_main_fb

page_ad_hoc_agenda_item_fb

page_member_rename_qwerty fb

page_meeting_type rename_qgwerty fb

page_seating_chart_fb

gwerty_a ... qwerty_capslock
record_attendance

attendance_user_xx

attendance_all_present
attendance_all_absent............o
AV 7o) LTS - o
vote_end
vote_clear

vote_mode_unanimous
vote_mode_2/3
vote_mode_3/4
vote_mode_4/5
vote_mode_majority
vote_timer_minute_up

vote_timer_minute_down

vote_timer_enable

vote_timer_disable

pulse to connect to open the agenda in e-PowerPoint.
This signal needs to also be connected to the Shortcutl
input of the e-PowerPoint interface.

pulse to close the agenda in e-PowerPoint. This signal
needs to also be connected to the EndPowerPoint input
on the e-PowerPoint interface.

pulse to end the meeting. This process includes
saving the user names and seating chart for the
current meeting type. This must absolutely be
pulsed before selecting a new meeting type.

route from digital feedback indicating the touchpanel is
on the splash page

route from digital feedback indicating the touchpanel is
on the main page

route from digital feedback indicating the touchpanel is
on the page for entering an ad hoc agenda item on the
keyboard

route from digital feedback indicating the touchpanel is
on the page for renaming a member on the keyboard
OR selecting a member (see demo program)

route from digital feedback indicating the touchpanel is
on the page for renaming a meeting type on the
keyboard OR selecting a meeting type (see demo
program)

route from digital feedback indicating the touchpanel is
on the page for modifying the seating chart

route from buttons for on-screen QWERTY keyboard
pulse to record the current attendance to compact
flash and Excel (including status of each member)
pulse to change the current attendance status of the
selected user (absent vs. present)

pulse to mark all users present

pulse to mark all users absent

pulse to begin voting on the current agenda item

pulse to stop voting on the current agenda item

pulse after reviewing the results to reset the voting
system for the next item.

pulse to require 100% of the vote to pass

pulse to require 2/3 or more of the vote to pass

pulse to require 3/4 or more of the vote to pass

pulse to require 4/5 or more of the vote to pass

pulse to require a majority of the vote to pass

pulse to increase the amount of time used by the vote
timer
pulse to
timer
pulse to enable the vote timer. This will start a count
down at the beginning of each vote, and automatically
close the vote when the time runs out.

pulse to disable the vote timer

decrease the amount of time used by the vote

Crestron Voting Module V2
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vote_auto_close _on

vote_auto_close_ off
vote_body_total

vote_body_ present

user_xx_yea
USEE_ XX NAY +tuntetteeeaeeeeane e eat e e eaa e e eaneeeaeeeaaneeaaneeens
user_XxX_abstain ... ...ccoviiiiiii s
user_xx_request_to_speak

user_xx_cancel_request_to_speak

user_xx_done_speaking

queue_xx_select

kill_selected_queue

kill_all_users
clear_floor

give_selected_user_floor

give_user_in_queue_1_floor

floor_timer_minute_up

floor_timer_minute_down
floor_timer_enable

floor_timer_disable

member_xx_select
seat Xxx_select

meeting_type_Xxx

meeting_type_Xx_rename
member_xx_rename

ANALOG INPUTS

This module does not utilize any analog inputs

SERIAL INPUTS
e_powerpoint_slide_name$

pulse to turn “auto close” on. While auto close is on,
the system will automatically close the vote once all
users have cast their vote.

pulse to turn “auto close” off

pulse to calculate voting results on the basis of the
total number of members in the body

pulse to calculate voting results on the basis of the
number of members who are current present (based
on the current_attendance output)

pulse when the selected user votes “yea”

pulse when the selected user votes “nay”

pulse when the selected user votes “abstain”

pulse when the selected user would like to request a
chance to speak

pulse when the selected user would like to give up his
or her place in the “request to speak” queue

pulse when the selected user is done speaking and
wishes to relinquish the floor

route to buttons on the administrator’s touchpanel to
select a user in the queue

pulse to remove the user selected using the
queue_xx_select buttons from the queue

pulse to remove all users from the queue

pulse to remove the member who currently has the
floor and leave the floor empty

pulse to give the floor to the user selected using the
queue_xx_select buttons

pulse to give the user in queue slot #1 the floor, and
advance all other users to the next slot

pulse to enable the floor timer. This will start a count
down when a user is given the floor, and automatically
clear the floor when the time runs out.

pulse to disable the floor timer

pulse to increase the amount of time used by the floor
timer

pulse to decrease the amount of time used by the floor
timer

pulse to select a member on the seating chart

pulse to select a seat on the seating chart for the
selected member

pulse to select a meeting type at startup. This will load
the database of names and seating assignments for the
selected meeting type.

pulse to select a meeting type to rename

pulse to select a member to rename

route from slide_name$ output of e-powerpoint symbol

Crestron Voting Module V2
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DIGITAL OUTPUTS
e_powerpoint_subpage fb

page_splash

page_main

page_start_up_progress

page_shut_down_progress

gwerty_shift_fb
gwerty_capslock fb

record_attendance_fb

attendance_user_xx_present_fb
attendance_user_xx_absent_fb
vote_display_fb

vote_start_fb
vote_end_fb

vote_start_successful

vote_start_unsuccessful

vote_mode_unanimous_fb
vote_mode 2/3 fb
vote_mode_3/4_ fb
vote_mode_4/5 fb
vote_mode_majority fb
vote_pass_fb
vote fail fb
vote_timer_enable fb
vote_timer_disable fb
vote_timer_display fb

vote_auto_close_on_fb
vote_auto_close_off fb
vote_body_total fb

route to subpage on your character generator (i.e.
TPS-G-TPI) that will display the agenda information.
This signal is high while agenda information is being
displayed.

route to the touchpanel join number. This signal goes
high when the module requests the panel to be sent to
the splash screen.

route to the touchpanel join number. This signal goes
high when the module requests the panel to be sent to
the main screen.

route to the touchpanel join number. This signal goes
high when the module requests the panel to be sent to
the start up progress screen.

route to the touchpanel join number. This signal goes
high when the module requests the panel to be sent to
the shut down progress screen.

route to feedback for shift button on QWERTY keyboard
route to feedback for caps lock button on QWERTY
keyboard

route to feedback for record_attendance button. This
will make the button blink while the system is busy
recording the attendance.

high while the user is marked present

high while the user is marked absent

route to subpage on your character generator (i.e.
TPS-G-TPI) that will display voting results. This signal
is high while voting results are being displayed.
feedback for the vote_start button (held high while
voting is in progress)

feedback for the vote_end button (held high while
voting is not in progress)

this signal goes high when a vote begins OK. Use this
to flip to the voting page on the user’s touchpanel (if
applicable)

route to a popup message on the administrator’s
touchpanel. This signal goes high for 3 seconds if the
vote cannot be opened because all group members are
absent.

high when 100% of the vote is required to pass

high when 2/3 of the vote is required to pass

high when 3/4 of the vote is required to pass

high when 4/5 of the vote is required to pass

high when a majority of the vote is required to pass
goes high when a vote passes

goes high when a vote fails

high when the vote timer is enabled

high when the vote timer is disabled

route to subpage on your character generator (i.e.
TPS-G-TPI) that will display the voting timer. This
signal is high while voting is in progress.

high when “auto close” is enabled

high when “auto close” is disabled

high to indicated the system will calculate voting
results on the basis of the total number of members in
the body

Crestron Voting Module V2
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vote_body present fb.......coooiiiiiiii high to indicated the system will calculate voting
results on the basis of the number of members who
are current present (based on the current_attendance

output)
user_xXxX_yea fh.....o high to indicate the selected user has voted “yea”
user_xx_nay b high to indicate the selected user has voted “nay”
user_xx_abstain_fb........ooooiiiii high to indicate the selected user has voted “abstain”
user_XX_No_vote_fb ... high to indicate the selected user did not vote
user_Xx_yea led ... If using keypads for voting, route this signal to the LED

“Yea” feedback of the keypad. The user’s LED wiill
blink while the voting is still active (indicating the vote
may be changed) and then latch solid once the vote
has closed.

user_ XX _Nay_led ... If using keypads for voting, route this signal to the LED
“Nay” feedback of the keypad. The user’s LED will
blink while the voting is still active (indicating the vote
may be changed) and then latch solid once the vote
has closed.

user_xx_abstain_led ... If using keypads for voting, route this signal to the LED
“Abstain” feedback of the keypad. The user’s LED will
blink while the voting is still active (indicating the vote
may be changed) and then latch solid once the vote

has closed.
error_no_compact_flash_ media.........cccoooiiiiiiiiiin.o. Goes high to indicated that there is no compact flash
media inserted in the Crestron processor
user_xx_request_to_speak_led...........cooiiiiiiiiiinL. If using keypads for request to speak, route this signal

to the LED “Request to Speak” feedback of the keypad.
The user’s LED will blink while in the queue, and then
latch solid when the user is given the floor.

user_xx_cancel_request_to_speak popup mv.............. If using touchpanels for request to speak, route this
signal to a subpage on the user’s touchpanels. This
signal will go high for 3 seconds when the user cancels
his or her own request to speak.

user_xx_done_speaking_popup_MV .....cc.cceeviieiiinnannn.. If using touchpanels for request to speak, route this
signal to a subpage on the user’s touchpanels. This
signal will go high for 3 seconds when the user is done
speaking and relinquishes the floor.

user_xx_Killed _popup_MV.....coiiiiiiiiiiiic i If using touchpanels for request to speak, route this
signal to a subpage on the user’s touchpanels. This
signal will go high for 3 seconds when the user is
removed from the queue by the administrator.

user_xx_has_floor_fb......... high when the selected user has the floor

user_xx_next_to speak fb ... high when the selected use is next to speak

user_xx_not_in_queue_page_flip........ccooooiiiiit. If using touchpanels for request to speak, route this
signal to flip to the “not in queue” page on the user’s
touchpanel.

user_xx_in_queue_fb ... high when the selected use is in the queue and in

position 2 or higher (when the user in queue position
1, user_xx_next_to_speak fb will be high instead)

queue_xx_select_fb ... feedback for buttons on the administrator’s touchpanel
to select a user in the queue
all_users_Killed ... If using touchpanels for request to speak, route this

signal to a subpage on the user’s touchpanels. This
signal will go high for 3 seconds when all users are
removed from the queue by the administrator.

queue_Tull ..o e high once ten users are already in the queue, and no
more can be accepted

Crestron Voting Module V2 ControlWorks Consulting, LLC
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floor_timer_display_fb

floor_timer_enable_fb
floor_timer_disable_fb
member_xx_select_fb
seat_xx_select_fb
seat_assignment_working

lockout_floor_change ......ovoviiiiiiii e
meeting_type_xx_fb
meeting_type_xx_rename_fb

member_xx_rename_fb

seat_x_unused_fb

ANALOG OUTPUTS

e_powerpoint_slide_count
e_powerpoint_slide_characters

system_start_up_progress_for_touchpanels

system_shut_down_progress_for_touchpanels

system_start_up_clock
system_shut_down_clock

current_attendance

current_number_absent

AV L0Y (=T T/=T- VP

votes_nay

votes_abstain

VOtES_total ...

votes_pending

votes _did_not_vote

vote timer_value

vote_timer_seed_value

route to subpage on your character generator (i.e.
TPS-G-TPI) that will display the floor timer. This signal
is high while the floor timer is running.

high when the floor timer is enabled

high when the floor timer is disabled

indicates the selected member on the seating chart
indicates the selected seat on the seating chart

high when the system is busy working on saving a new
seating assignment

high when the system is busy processing a new user
for the floor, and is not yet ready for another change
indicates the currently selected meeting type

indicates the meeting type that has been selected to
be renamed

indicates the member that has been selected to be
renamed

High when there is not a member assigned to the
indicated seat.

route to SlidesPagesLines input of e-PowerPoint symbol
route to SlidesPagesChars input of e-PowerPoint
symbol

route to a bar graph on the system start up progress
page

route to a bar graph on the system shut down progress
page

route to a timer on the system start up progress page
route to a timer on the system shut down progress
page

contains the current number of group members
present (as a decimal value)

contains the current number of group members absent
(as a decimal value)

contains the number of votes cast as yea (as a decimal
value)

contains the number of votes cast as nay (as a decimal
value)

contains the number of votes cast as abstain (as a
decimal value)

contains the total number of votes cast (as a decimal
value)

contains the total number of votes that have still not
yet been cast (as a decimal value)

at the end of the voting process, this will contain the
total number of users who did not vote (as a decimal
value)

route to a timer object on the administrator’s
touchpanel, user touchpanels, and/or the character
generator. This value contains the number of seconds
left in the vote counter as it counts down.

route to a timer object above the
vote_timer_minute_up and vote_timer_minute_down
buttons on the administrator’s touchpanel. This value
contains the number of seconds that will be used in the
vote timer the next time it is started.
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user_xx_place_in_queue

user_in_queue_count

floor_timer_value

floor_timer_seed_value

sequence_number

user_xx_mode

SERIAL OUTPUTS
€ data logS. ..o e
ad_hoc_gwerty$

member_name_qwerty$

meeting_type_qwerty$

user_xx_name$

queue_xx_name$
floor_name_slow$

floor_name_quick$
member_xx_name$

current_meeting_type$

meeting_type_xx$

contains the position in the queue for the selected user
as a decimal value. For instance, if the user is the fifth
in line to speak, the value is 5d.

contains the total number of users currently in the
request to speak queue (as a decimal value)

route to a timer object on the administrator’s
touchpanel, user touchpanels, and/or the character
generator. This value contains the number of seconds
left in the floor counter as it counts down.

route to a timer object above the
floor_timer_minute_up and floor_timer_minute_down
buttons on the administrator’s touchpanel. This value
contains the number of seconds that will be used in the
floor timer the next time it is started.

unique number of the current vote. This number is
reset to 1 when a new meeting is started, and
advanced with each vote that is taken. This allows
operators to identify each vote in the records.

drives multimode touchpanel objects. Outputs O when
a seat is “unused” and 1 when seat is “used”

route to DataTolLog input of e-datalog symbol

route to text field on QWERTY keyboard page for Ad
Hoc agenda items

route to text field on QWERTY keyboard page for
renaming group members

route to text field on QWERTY keyboard page for
renaming meeting types

contains the name of the selected user (based on
which seat the user is in)

name of the user in each queue slot

a delayed output field containing the name of the user
on the floor. If you are using pan/tilt/zoom cameras
and have a delay programmed to prevent the
television broadcast from containing movement, use
this signal on the character generator.

name of the user on the floor (populates immediately)
contains the name of the member (raw off the
database, before seating records are considered)
contains the name of the currently selected meeting
type

contains the names of the five different supported
meeting types
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Support

This module is supported by ControlWorks Consulting, LLC. Should you need support for this
module please email support@controlworks.com or call us at 440-449-1100. ControlWorks
normal office hours are 9 AM to 5 PM Eastern, Monday through Friday, excluding holidays.

Before calling for support, please ensure that you have loaded and tested operation using the
included demonstration program and touchpanel(s) to ensure that you understand the correct
operation of the module. It may be difficult for ControlWorks to provide support until the
demonstration program is loaded.

Updates, when available, are automatically distributed via Email notification to the address

entered when the module was purchased. In addition, updates may be obtained using your
username and password at http://www.thecontrolworks.com/customerlogin.aspx.

Distribution Package Contents

The distribution package for this module should include:

ControlWorks_Crestron_Voting_Module_Help_v2.pdf ..... this help file

ControlWorks_Voting_ V2.UMC......ccooiviiiiiiiiieiiiiieeanns Crestron user module to insert in program
ControlWorks_Concatenate_V1.USP ......oiiiiiieiiiiineaannnn. SIMPL+ module that is inside the UMC
ControlWorks_Concatenate_vil.ush ...l compiled SIMPL+ header
ControlWorks_Subtract_ VI.USP.....coeeviieeiiiiieiiiieiaieaans SIMPL+ module that is inside the UMC
ControlWorks_Subtract vi.ush............cciiiiiiiiiiiiiinn.. compiled SIMPL+ header

ControlWorks_Voting_Member_Name_Storage vl1.usp... SIMPL+ module that is inside the UMC
ControlWorks_Voting_Member_Name_Storage_v1.ush... compiled SIMPL+ header

StriNG QUE V. USSP ..ttt e e SIMPL+ module that is inside the UMC

String QuUe VI.USh. ... e compiled SIMPL+ header

Vote backup cflog VI.USP ..o SIMPL+ module that is inside the UMC

Vote backup cflog vi.ush......coooiiiiiiiiiii e compiled SIMPL+ header
ControlWorks_Voting_Demo_TPS-6000_v2.vtp ............. example administrator’s touchpanel (TPS-6000)
ControlWorks_Voting_Demo_CT-1000_v2.vtp............... example user’s touchpanel (CT-1000)
ControlWorks_Voting_Demo_TPS-TPl_v2.vtp................ example character generator file (TPS-TPI)
ControlWorks_Voting_Demo_V2.SMW .......ccceviieeiiieennnns example program (PRO2)
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Revision History

V2 tom@controlworks.com 2006.07.24

Added “did not vote” feedback

Added “current_number_absent” feedback

Added display of current voting rules to voting timer and voting results pages in demo touchpanels

Added logic to store the voting rules for each group separately on compact flash

Added ability to vote by 3/4 and 4/5

Modified voting timer increment to 5 seconds instead of 1 minute

Added voting sequence number output

Added ability to set a seat as "unused" and therefore ignored by all voting calculations and not displayed
on outputs. This provides support for groups of different sizes (i.e. City Council has 11 members
and School Board has 7)

Modified demo touchpanel page joins to resolve issues with keyboards if project converted to Xpanel

V1 tom@controlworks.com 2006.06.28
Initial release in module form.

Development Environment
This module version was developed on the following hardware and software. Different versions
of hardware or software may or may not operate properly. If you have questions, please contact
us.

Hardware

Crestron PROZ2 ProCESSOr ...ttt eeeeeees v3.155.1143

Crestron TPS-6000 Touchpanel .......ccoviiiiiiiiiiii s v2.002

Software

Crestron SIMPL WINAOWS ......iiiiiiii e e eeeas Version 2.07.32

Crestron Database ........oooi i Version 18.1.5

Crestron Symbol Library .......ccooviiiii e Version 387

Crestron Device Library ... ..o Version 387

Crestron Vision TooIS Pro-E ... Version 3.5.0.7 Build 20060511:2
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ControlWorks Consulting, LLC Module License Agreement

Definitions:

ControlWorks, We, and Us refer to ControlWorks Consulting, LLC, with headquarters located at 701 Beta Drive,
Suite 22 Mayfield Village, Ohio 44143-2330. You and Dealer refer to the entity purchasing the module. Client
and End User refer to the person or entity for whom the Crestron hardware is being installed and/or will utilize
the installed system. System refers to all components described herein as well as other components, services,
or utilities required to achieve the functionality described herein. Module refers to files required to implement
the functionality provided by the module and may include source files with extensions such as UMC, USP, SMW
and VTP. Demo Program refers to a group of files used to demonstrate the capabilities of the Module, for
example a SIMPL Windows program and VisionTools Touchpanel file(s) illustrating the use of the Module but not
including the Module. Software refers to the Module and the Demo Program.

Disclaimer of Warranties

ControlWorks Consulting, LLC software is licensed to You as is. You, the consumer, bear the entire risk relating
to the quality and performance of the Software. In no event will ControlWorks Consulting, LLC be liable for
direct, indirect, incidental or consequential damages resulting from any defect in the Software, even if
ControlWorks Consulting, LLC had reason to know of the possibility of such damage. If the Software proves to
have defects, You and not Us must assume the cost of any necessary service or repair resulting from such
defects.

Provision of Support

We provide limited levels of technical support only for the most recent version of the Module as determined by
Us. We do not provide support for previous version of the module, modifications to the module not made by Us,
to persons who have not purchased the module from Us. In addition, we may decline to provide support if the
Demo Program has not been utilized. We may withdraw a module from sale and discontinue providing support
at any time and for any reason, including, for example, if the equipment for which the Module is written is
discontinued or substantially modified. The remainder of your rights and obligations pursuant to this license will
not be affected should ControlWorks discontinue support for a module.

Modification of Software

You may not decrypt (if encrypted), reverse engineer, modify, translate, disassemble, or de-compile the Module
in whole or part. You may modify the Demo Program. In no event will ControlWorks Consulting, LLC be liable for
direct, indirect, incidental or consequential damages resulting from You modifying the Software in any manner.

Indemnification/Hold Harmless

ControlWorks, in its sole and absolute discretion may refuse to provide support for the application of the Module
in such a manner that We feel has the potential for property damage, or physical injury to any person. Dealer
shall indemnify and hold harmless ControlWorks Consulting LLC, its employees, agents, and owners from any
and all liability, including direct, indirect, and consequential damages, including but not limited to personal
injury, property damage, or lost profits which may result from the operation of a program containing a
ControlWorks Consulting, LLC Module or any component thereof.

License Grant

Software authored by ControlWorks remains the property of ControlWorks. ControlWorks grants You the non-
exclusive, non-transferable, perpetual license to use the Software authored by ControlWorks as a component of
Systems programmed by You. This Software is the intellectual property of ControlWorks Consulting, LLC and is
protected by law, including United States and International copyright laws. This Software and the
accompanying license may not be transferred, resold, or assigned to other persons, organizations or other
Crestron Dealers via any means.

The use of this software indicates acceptance of the terms of this agreement.

Copyright (C) 2009 ControlWorks Consulting, LLC All Rights Reserved — Use Subject to License.
US Government Restricted Rights. Use, duplication or disclosure by the Government is subject to restrictions set
forth in subparagraphs (a)-(d) of FAR 52.227-19.
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